Advanced Joomla - Build Home and News Pages

Laura Gordon

SASIT – Web Development

October 2019
# Table of Contents

Class Goals .................................................................................................................................................................................. 3
  Welcome & Introductions................................................................................................................................................................. 3
  Class Goals ...................................................................................................................................................................................... 3
  Additional Training / Documentation ............................................................................................................................................... 3
  Class Site.......................................................................................................................................................................................... 3

Static Square Button Modules .......................................................................................................................................................... 4
  Create Custom Module...................................................................................................................................................................... 5
  Class Exercise – add Modules ......................................................................................................................................................... 6

News Module on Page ........................................................................................................................................................................... 7
  Overview............................................................................................................................................................................................ 7
  Create LNE Module ........................................................................................................................................................................ 8
  Selection Settings .......................................................................................................................................................................... 8
  Layout Settings ................................................................................................................................................................................. 9
  Additional Layout Settings ............................................................................................................................................................. 10
  Image Settings ............................................................................................................................................................................... 11

Clear Cache – View Images ............................................................................................................................................................... 12
  Clear Joomla Cache ........................................................................................................................................................................ 12
  Open in New Browser ................................................................................................................................................................... 12
  Clear LOCAL Browser Cache ......................................................................................................................................................... 12

People Pages ..................................................................................................................................................................................... 12
  Person detail page ......................................................................................................................................................................... 12
  Build Category Blog People Page ............................................................................................................................................... 13

Create LNE Blog – 1 Across ............................................................................................................................................................. 14
  Define: Selection, Head, Title ........................................................................................................................................................ 14
  Define: Text, Link, Head Image, Information ............................................................................................................................... 15
  Sample Output ............................................................................................................................................................................... 16

Create LNE Blog – 3 Across ............................................................................................................................................................. 17
  Define: Selection, Head, Title, Text ........................................................................................................................................... 17

Filter by Tags ..................................................................................................................................................................................... 19
CLASS GOALS

WELCOME & INTRODUCTIONS
School of Arts & Sciences, Web Development

CLASS GOALS
Build and design your home page using
- Static modules
- News Module

Create people page using custom fields
- Category blog view
- News view, how we can select specific fields to display in different layouts

Build news page
- Use filtering by news items

ADDITIONAL TRAINING / DOCUMENTATION
Training: https://sasit.rutgers.edu/how-to-guides/web-development-documentation

Sample website: https://www.sas.rutgers.edu/cms/deptdemo

CLASS SITE
Site we will be using today

https://www.sas.rutgers.edu/cms/training

https://www.sas.rutgers.edu/cms/training/administrator
**Static Square Button Modules**

All of our SAS websites use ‘square’ button modules on the bottom of the home page to use as additional navigation features for the website. We recommend these links be links that are normally ‘tucked away’ from the top menu such as ‘Undergraduate’, ‘Study abroad’, ‘events’. Each square button should link to a specific menu item on the website.
CREATE CUSTOM MODULE
- Extensions → Modules
- Click NEW for new module
- Type = CUSTOM MODULE

Fields for module:
- Title: L-Undergraduate. (where L is your INITIAL)
- Position: Mainbottom-A

Content:
- Upload image from folder bottom-images
- Click on image, assign a LINK to the image

Menu Assignment:
- Select MENU Assignment Tab
- Select ONLY ON PAGES SELECTED
- Click on NONE
- Find your Menu item (YOUR NAME) – CHECK IT!
- Click SAVE & CLOSE
Sample Display:

CLASS EXERCISE – ADD MODULES
Add modules to the following positions (put your initial to the left of each title)

- Graduate → mainbottom-b
- Faculty → mainbottom-c
- Centers → mainbottom-d

It’s possible to COPY a module that already exists (save as copy), just change

- Title, image, image link, position

Sample Page:
NEWS MODULE ON PAGE

OVERVIEW
There are several ways to display news articles from the website. It’s possible to display just a ‘list’ in a vertical view or if you have images, the news items can be displayed horizontally with a square image ‘generated’ from each article

Sample view
- Geography.rutgers.edu
- Eps.rutgers.edu

Definition of Training Site
- Content ➔ Categories
- Find NEWS Category
- Click on GREEN oval, see the articles in this category

Documentation for Latest News Enhanced:
https://simplifyyourweb.com/documentation/latest-news
CREATE LNE MODULE
Create NEW Module

- Type: Latest News Enhanced Module
- Title: L-News (where L is your initial)
- Position: Extension-a
- Menu Assignment: PAGES SELECTED, SELECT JUST YOUR PAGE

![Latest News Enhanced Module](image)

SELECTION SETTINGS
- Category → NEWS
- Sub-categories → ALL Levels, if you may want articles within levels of categories
- Order → Recently Published First
- Max Count → 4 (number of articles to display)

This will select only the articles in the NEWS Category

It is possible to select by Category(s) AND/OR TAGS

Definition of Tags/Categories

- An Article can only exist in ONE CATEGORY (it is a hierarchy system)
- An Article CAN have MULTIPLE TAGS

![Selection Settings](image)

Hit save, and view your page on the website
**LAYOUT SETTINGS**

Initially the display will be vertical without images, and it will just be a long listing

![Layout Settings](image)

**Result:**

- Set Configuration to HORIZONTAL
- All Items...
  - Set Item width = 25% (show 4 across)
  - Min width = 250px

**Head...**

- Image Type – Image from content
- Head: 250px x 250px
ADDITIONAL LAYOUT SETTINGS

**TITLE**
- Element: Title (or you can select a field name)
- Letter Count Max: 100
- HTML Header Tag: H3

**TEXT**
- Intro
- Letter Count Max: 0

**LINKING**
- Like on: Title & Head (makes image clickable)
- Link to: Item (or can go to a ‘weblink field’)

Result:
**IMAGE SETTINGS**

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Thumbnails</td>
<td>YES</td>
</tr>
<tr>
<td>Crop Pictures</td>
<td>YES</td>
</tr>
</tbody>
</table>

This will set all images to be the same size.

Result:

![Image Examples]

The PHP `allow_url_fopen` setting must be enabled in order for thumbnails to be created and cropped images to be resized.

The PHP `gd` extension is required for creating thumbnails. It is enabled by default.

The PHP `gd` extension is loaded (version 2.2.35)

- GIF enabled
- JPG enabled
- PNG enabled
CLEAR CACHE – VIEW IMAGES
The images are generated via cache, which means that at times you may see ‘older images’, even if you know you changed them.

CLEAR JOOMLA CACHE
System → Clear Cache → DELETE ALL (Click button), YES YOU CAN DELETE ALL

OPEN IN NEW BROWSER
Copy the url for your page then open in a new browser window. This can confirm that everything is setup properly, it is just a ‘cache issue’.

CLEAR LOCAL BROWSER CACHE
- Chrome
- Click on ‘top 3 small buttons’ on top right side of page
- Click HISTORY
- Click on LEFT – Clear Browsing Data
- Remove all
- (this will clear out any passwords you may have saved over time, you may need to re-login

PEOPLE PAGES
People pages can be displayed in many different ways in Joomla. Each ‘person’ should always be an individual article in joomla. In this environment we already created custom fields for each person.

PERSON DETAIL PAGE
BUILD CATEGORY BLOG PEOPLE PAGE

- Menus. → Main Menu
- Click NEW MENU ITEM
- Title: Name - Faculty Blog
- Menu Item Type: Articles → Category Blog
- Choose category – Faculty
- Options tab →
  - # Leading Articles = 0
  - # Intro Articles = 10
  - # columns = 1
  - # Links = 0
- Parent Item → LNE Blogs

Could be done better:

1. Display of ‘linked title’ is lastname, first name
2. Images are not the same size
3. What if I want ‘readmore’
4. What if I don’t want to display all of the fields
5. What if I want to display horizontally? With just the image and the title?
CREATE LNE BLOG – 1 ACROSS
EDIT the menu item that was created in the last exercise.

- Menus → Main Menu → Menu items
- Search for your NAME - CLICK on NAME – Faculty Blog
- Change Menu Item Type = Latest News Enhanced → BLOG

DEFINE: SELECTION, HEAD, TITLE
Selection Tab

- Category(s) → Faculty
- Order → Title Asc

Layout Tab

Leading Items → Leave this area blank

Remaining Items

- Item Width = 100%
- Item Min Width = 250px

Head

- Head Type → People Fields: Portrait Image
- Width: 250px
- Height: 250px
- Position: Left

Title

- Element – People Fields: Formatted Name
- Letter Count Max – 100
- HTML Header Tag – H3

Display Result
**Define: Text, Link, Head Image, Information**

**Text**
- Letter Count Max: 800
- Wrap: YES

**Linking**
- Link on: Title, Head, read more
- Link to: Article (you can also link to a ‘website’, if there is one)
- Link Label: Read More

**Theming**
- Read more class → button

**Head: Image**
- Crop Pictures: YES

**Information (TAB)**
This gives you the capability of selecting specific fields to display.

**Information Before Text**
Click Green Plus for each field that you want to add

- Type: People Fields: Position
  - CSS Classes: large-normal
  - Append New Line: Yes
- Type: People Fields: Email Address

It's possible to define styles for all of the fields that are added in ‘information’

**Sample styles:**

![Faculty Image](image.png)
<table>
<thead>
<tr>
<th>Name</th>
<th>Title</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thomas Cole</td>
<td>Senior Counselor</td>
<td><a href="mailto:tcole@email.com">tcole@email.com</a></td>
</tr>
<tr>
<td>Bruce Crawford</td>
<td>Assistant Professor</td>
<td><a href="mailto:bcrawford@email.com">bcrawford@email.com</a></td>
</tr>
<tr>
<td>Timothy Cruz</td>
<td>Senior Counselor</td>
<td><a href="mailto:tcruz@email.com">tcruz@email.com</a></td>
</tr>
</tbody>
</table>

CREATE LNE BLOG – 3 ACROSS

EDIT the menu item that was created in the last exercise.

- Menus → Main Menu → Menu items
- Search for your NAME - CLICK on NAME – Faculty Blog

DEFINE: SELECTION, HEAD, TITLE, TEXT

Layout Tab

Leading Items → Leave this area blank

Remaining Items

- **Item Width = 25%**
- Item Min Width = 250px

Head

- Head Type → People Fields: Portrait Image
- Width: 250px
- Height: 250px
- **Position: TOP**

Title

- Element – People Fields: Formatted Name
- Letter Count Max – 100
- HTML Header Tag – H3

Text

- Letter Count Max: 0
- Wrap: No

Linking

- Link on: Title, Head, read more (NOT READ MORE)
- Link to: Article (you can also link to a ‘website’, if there is one)
- Link Label: Read More (REMOVE TEXT)
FILTER BY TAGS

If your content is using Tags, it’s possible to add a ‘filter’ to your LNE Menu item, so it’s easy to ‘toggle’ between different options.

Our data has tags of Faculty Specialties

Sample person with tags...

---

We also have a TEXT FIELD, for Specialties

We include a text field, because it displays better on the front end as just ‘text’. Yes, this means you are entering the information twice.
Edit Latest News Enhanced Menu item

EDIT the menu item that was created in the last exercise.

- Menus → Main Menu → Menu items
- Search for your NAME - CLICK on NAME – Faculty Blog

Information Tab

- Add SPECIALTIES field

Pagination Tab

Standard Pagination:

- Type: Standard
- Pagination results: hide
- Total: Hide
- # of cards per page 20

Indexing

- Position 1 → Tags
- Tags Index → Selection Box
- Tag order → Title Asc

Sample Result: